Description

Simple Slab Deck

For LUSAS version: 24.0
For software product(s): | LUSAS Bridge.
With product option(s): | None.

Description

A simply supported bridge structure consisting of an in-situ slab deck is to be analysed.
The geometry of the deck is as shown. The slab has 0.5m thick carriageways and 0.4m
thick footways.
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The structure is subjected to loading defined in the Departmental Standard BD 37/88
Loads for Highway Bridges.

The units of the analysis are kN, m, t, s, C throughout.
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Modelling

Simple Slab Deck

Objectives

The required output from the analysis consists of:

U A deformed shape plot showing displacements caused by the imposed loading
U A diagram showing the bending moments in the slab

Keywords

3D Beam/Shell, Bridge Loading, Moving Load, Eccentricity, Basic Load
Combination, Load Envelope, Peak Values, Deformed Mesh, Contours, Graphing.

Associated Files

Associated files can be downloaded from the user area of the LUSAS website.

U bridge_slab_modelling.lvb carries out most of the modelling of the
example. After running the script go to the heading entitled Assigning the
Moving HB Vehicle Load and continue from this point.

Note. Model and results images included in this example were captured in an earlier
version and may differ in appearance from those seen and obtained from this version.

Running LUSAS Modeller

For details of how to run LUSAS Modeller, see the heading Running LUSAS
Modeller in the Introduction to LUSAS Worked Examples document.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File
> New to start a new model file. Modeller will prompt for any unsaved data and display
the New Model dialog.

Creating a new model

e Enter the file name as bridge_slab

e Use the Default working folder.

e Ensure an Analysis type of Structural is set.
e Set the Analysis category as 3D

e Change the model units to kN,m,t,s,C

e Ensure that timescale units are Seconds




| Geometry
Line >
By Coords...
| Geometry
Surface >
By Sweeping...
| Geometry
Surface >
By Sweeping...

Modelling

e Select the Startup template 3D Beam/Shell
e Ensure the Layout grid is set as None
e Enter the title as Simple Bridge Slab Analysis

e C(Click OK

The Attributes & treeview will be populated with potentially useful basic line mesh,
material, geometric and support entries appropriate to the settings made.

Note. An analysis category of 3D and a 3D Beam/Shell template is specified because
eccentricities will be defined that provide in-plane effects, which cannot be obtained
from a 2D model.

Note. Use the undo button to correct a mistake. The undo button allows any number

of actions since the last save to be undone.

Defining the Material

Ungraded concrete material is provided by the startup template.

o Select the Concrete (Ungraded | Concrete) attribute from the & Treeview
with the right-hand mouse button and select Set Default to make concrete the
default material for all newly created features.

Feature Geometry

il Enter coordinates of (0, 0), (10.5, 0) to define the lower Line. Use the Tab key to
move to the next entry field on the dialog. With all the coordinates entered click the
OK button.

e Select the line.
él Sweep the line through a translation of X= -1.5, Y= 1.5, Z = 0 and click OK to
create a Surface which defines the lower footway.

e Select the Line at the top of the footway.

él Sweep the Line through a translation of X= -7, Y=7, Z= 0 and click OK to create
a Surface which defines the carriageway.

e Select the Line at the top of the carriageway.




| Geometry
Surface >
By Sweeping...
| Geometry
|Suface >
| Geometry
Surface >
Reverse Normal...

Simple Slab Deck

él Sweep the Line through a translation of X= -1.5, Y= 1.5, Z= 0 and click OK to
create a Surface which defines the upper footway.

Checking Local Element Directions

In creating the surfaces by sweeping lines, the Surface axes will not necessarily be in
the required orientation. In this example the surface axes should be checked and
corrected.

e In the & Treeview double click
Geometry entry and select the
surface axes option.

e C(Click the OK button to display
the element axes.

A

The element axes should all be oriented \’*v
to lie along the global X axis but instead will look as shown on the adjacent image. To
correct this:

e Select the 3 surfaces.
e Press the Apply button once and then press Close.

With the surfaces still selected:

The surface axes should now look as

shown to the right. B
Now turn-off the
display of the surface
axes: l
e In the Treeview double click b

the Geometry layer.




| Edit

| Select Al

Modelling

e De-select the Surface axes option and click the OK button.

Defining a Surface Mesh

A 3D Thick shell surface mesh is provided by the startup template. To assign the mesh
to the model all features must be selected:

e Select all the features of the model, (press the Ctrl and A keys at the same
time).

e Drag and drop the Surface mesh attribute Thick shell, linear order from the A
Treeview onto the selected features.

The mesh will be displayed with each Line being split according to a default number of
divisions (4) specified for each line.

Note. One way of controlling the mesh density is by specifying the number of mesh
divisions along each Line. Since Modeller is fully associative, this will control Surface
mesh density.

Using Line Mesh Divisions

In this example 8 divisions per Line are required for the longitudinal Lines and
transverse Line representing the carriageway. Several Line mesh divisions are defined

by default. These can be seen in the A Treeview.

e Select the 4
longitudinal Lines
as shown. Hold the
Shift key down
after selecting the
first Line to add the
other Lines to the
selection. -

e Still holding the
Shift key, select the 2 transverse Lines of the middle surface representing the
carriageways.

e Drag and drop the Line mesh attribute Null, div = 8 from the &% Treeview onto
the selected features.

The mesh will be re-displayed to show 8 mesh divisions along each selected line.




| Attributes

Geometric >
Surface...
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Note. Holding down the L key while selecting features ensures that only lines will be
selected. Similarly, the P key limits the selection to Points, the S key; Surfaces, the V
key; Volumes and the G key; Geometry. Similar shortcuts exist for elements, nodes,
etc., which can be found in the Online Help.

Defining the Slab Thickness and Eccentricity

The slab is 0.5 m thick in the carriageway region and 0.4 m thick beneath the footways.

e Enter a thickness of 0.5 and leave the eccentricity field empty.
o Enter the attribute name as Thickness 0.5

e Click the Apply button to define the first geometry attribute and allow another
dataset to be defined.

e Change the thickness to 0.4

Element local z axis

Eccentricity measured
from mid surface of
0.4m thick slab to nodal
line in element local z
direction.

Nodal line at
Mid surface of slab Ce_ntre of 0.5m
in footway region thick slab

Note. The direction of the eccentricity is measured from the mid-surface of the slab to
the nodal line in the local element direction which follows the local surface direction.
Since in this example the mid-surface of the slab representing the footway is above the
nodal line, and the element local Z axis direction is vertically up, the eccentricity is
input as negative.

o Enter the eccentricity as -0.05
e Change the attribute name to Thickness 0.4
e Click the OK button to finish.

The thickness is now assigned to each Surface.

o Seclect the central Surface representing the carriageway.




| Attributes

Local Coordinate. ..

Modelling

e Drag and drop the geometry attribute Thickness 0.5 from the &% Treeview onto
the selected surface. Click OK to assign to the selected features for Analysis 1.

Geometric assignments are visualised by default.

e Select the outer two footway Surfaces, (hold down the Shift key to add the
second Surface to the selection).

e Drag and drop the geometry attribute Thickness 0.4 from the &% Treeview onto
the selected surfaces. Click OK to assign to the selected features for Analysis 1.

El Select the isometric

button to see the geometric
visualisation on the
members.

El The Zoom in button

can be used to check the eccentricity has been assigned correctly.

@l Select the Home button to return the model to the default view.
!l Select the fleshing on/off button to turn-off the geometric visualisation.

ﬁl If necessary, select the Fleshing default option to see a transparent view of the
model

Supports

The more common types of support are provided in the oo Treeview by default. In this
example the slab deck is to be restrained in the vertical and lateral direction at the
abutment edges, Additionally, a single pinned support will be assigned to one point on
the deck to prevent rigid body motion.

Before the supports can be assigned a local coordinate system needs to be defined so
the lateral displacement can be restrained in the skew direction along the length of the
abutment edges.

o Enter an angle of 45 for the rotation about the Z-axis.

e Enter the dataset name as Skew and click OK to add the Local coordinate
attribute to the A Treeview.

By default, the new Skew local coordinate system, is visualised within the view global
axes.
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To assign the abutment supports:

e Select the six = N
B S
1 R b
transverse.: Lines A N
representing the N N
end diaphragms N A\
. ~ AN
(ensure the Shift N .
key is used to add N AN
to the initial AW N
selection) N N
et e
K AN

e Drag and drop the
local coordinate attribute Skew onto the selected Lines.

e Drag and drop the support attribute Fixed in YZ onto the selected Lines.
The Assign Support dialog will be displayed.
e Ensure that the attribute is assigned to All analysis loadcases

e C(Click the OK button to finish.

To assign the pinned = S\
support: s =
N N
e Select the single N AN
) N N\
Point at the x,y,z AN N
axis origin AN N
\\ \\
e Drag and drop the
_ R N
support attribute e y
Pinned onto the /\!\ \\

selected Point.
The Assign Support dialog will be displayed.
e Ensure that the attribute is assigned to All analysis loadcases

e C(Click the OK button to finish.

elements can be eliminated from the element formulation by deselecting the following
element option. This will remove ill-conditioning of the equations and reduce the
problem size. It should however be noted that if moment supports are to be applied

Note. Since the slab is flat the in-plane rotation degrees of freedom for the thick shell
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with this option deselected, rotation about the Z axis must be restrained to eliminate
mechanisms in the solution.

| File e Select the Options tab and select the Element Options button. Deselect the
[ Model Properties.... _ option to Assign 6 DOF to all thick shell element nodes and click the OK
button to return to the Model Properties. Click OK to return to the display.

Defining the Loads

Four loadcases will be defined:

U The self-weight of the slab (ignoring any surfacing loads).

O A patch load equivalent to a traffic load over the full length and width of the
upper traffic lane.

O A knife edge load acting at mid-span of the upper lane.
U An HB vehicle in the lower lane.

Self-weight

The self-weight is defined using acceleration due to gravity in the negative Z direction.
A body force loading attribute representing gravity is provided by the startup template.
This will be assigned to the model shortly.

Lane Load

| Bridge The second load will represent a lane | tanetosd(atoss %

Bridge Loadin > load along the upper traffic lane. Loadng detais
United Kingdom... Loading code BD37/88 v %
0

. . . Loaded length (m) 105
e From the Vehicle Loading dialog ™= -
select the Lane load (HA Load) | scuvangere

button. Origin Certre <

o Sclect loading code BD37/88
from the pull-down list.

ve load | 40 Tonnes Invalid

& Heavy Traffic Paor Surface (Hp) Reduction factor, K= Invalid

0Ok Cancel Apply Help

e Enter the loaded length as 10.5,
leave the notional width set as 3.5, set the skew angle as -45 and the origin as

Centre, then click OK to add the lane load patch loading to the A Treeview.

Note. Sctting a skew angle on this patch load does not skew the whole load — it only
/ skews the ends of the patch load to match the angle of the skewed deck.
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Knife Edge Load

Knife Edge Load (KEL Load) x

Loading Data

Notional width (m)
Shewangle(des) [0 | ~

——
Ot s
Origin Centre

[] Assessment reduction factor

BD21/01 Loaded length (m) |30.0

e load |40 Tonnes 123

/e | Heavy Traffic Poor Surface (Hp) Reduction facter, K= 0.91

Cancel Apply Help

e From the Vehicle Loading dialog select the Knife edge load (KEL load)
button.

e [Leave the skew angle as 0 and click OK to add the lane load patch loading to
the & Treeview.

Abnormal Loading

e From the Vehicle Loading dialog | AbnomalLead 8 Vehicle -
select the Abnormal Load (HB Vehicle details
VehiCIe) button. Inner axle spacing (m) [ ~ [m !
38m|Tm
e Leave the Axle spacing as 6 and ot =0 |
the Number of HB units as 45 [ 50 2y i

and click OK to add the HB

vehicle point load to the &
Treeview.

Cancel Apply Help

o Select Close to close the Vehicle Loading dialog.

Assigning the Self-weight Load

e To assign the gravity loading select all active features using the Ctrl + A keys

together and drag and drop the loading attribute Gravity vertical from the oo
Treeview onto the selected features.

10



| Geometry
| Point >
By Coords...

Modelling

The Loading Assignment dialog <~ 5
will be displfyed. ¢ ¢ \T —————— \5 \
. N AN
e Ensure that the Assign to N \
Surfaces button is selected \\ \-\
and click the OK button to \.\ \\
assign the load to Analysis N N N S NN NN

1, Loadcase 1. %P ***** 3\ "

The load  visualisation for
Loadcase 1 will be displayed.

e To rename Loadcase 1 in the @ Treeview expand Analysis 1 and select
Loadcase 1 with the right-hand mouse button, then choose the Rename option.
Overtype the loadcase name with the name Self Weight

Assigning the Lane Load and Knife Edge Loads

Lane loads and vehicle loads are represented by patch loads that are assigned to Points
which may form part of the model, or may be defined specifically to locate the bridge
loads as in this case:

El Enter coordinates as (-1.5, 6.75) and click the OK button to create a new Point in
the middle of the upper lane.

Iil Temporarily turn off the display of the loading so that the point defined can be
seen.

The patch and knife edge loads
can now be assigned to the Point
that has just been defined.

e Select the Point defined at
the centre of the upper
traffic lane.

e Drag and drop the loading
attribute Pch2 (HA

BD37/88 10.5m x 3.5m Skew= -45.0deg (Centre)) from the & Treeview onto
the selected Point.

11



Simple Slab Deck

The Loading Assignment dialog will | DisereteLoading assignment b
appear. Settings

() Project ento line (2D line beams and frames)
(®) Project over area (grillages, shells, and 3D space frames)
() Praject into volume (solids)

The loading option to Project over area

will have been automatically selected. cemirmen T s
Options for loads outside search area | Exclude All Load ~
e Opvertype the name of the loadcase ot t e [ =
to be HA & KEL upper Transformations | Speciy...
Loadcase
. Analysis | Analysis 1 ~
e Click OK to complete the ’
) Loadcase
assignment. Setas active loadcase
Load factor | 1.0 |

Iil Turn on the display of loading. = - =

The patch load will be visualised on the

model.
e e
L &
e
R e

Note. The number of patch load divisions in the patch is set in the ® Patch divisions

/ object. By default, ten patch divisions are used in the long direction of the entire patch.
For more detailed information on discrete point and patch loads refer to the on-line
help.

e With the Point defined at the centre of the upper traffic lane still selected, drag
and drop the loading attribute Pch3 (KEL 120kN Width=3.5m Offset=0

Skew=0.0deg (Centre)) from the A Treeview onto the selected Point.

e Select the loadcase name HA & KEL upper from the loadcase droplist and
click the OK button to assign the load.

12



Modelling

The assigned patch loading for the upper lane should be as shown.

12.0 kN

H2T0TkN

N42.0kN

/N N

Note. In this example the patch loading has been shaped to match the skew of the

deck, but it could have alternatively been defined oversize in length and when assigned
to the model any loading outside of the model could have been excluded as necessary.

If rebuilding a model or creating a model using the
supplied file.

If a previous analysis of this example has failed, you need to return to this point to
continue after having run the supplied file stated.

If you created the model using the supplied associated file, you need to continue from

this point to complete the modelling required.

Assigning the Moving HB Vehicle Load

The HB vehicle will be assigned to the points using the moving load generator. To use
this facility a line defining the path of the vehicle must be created.

e Click on an empty region of the model view window to clear the current

selection.
|Ge|_ci):;etry > il Enter coordinates of (-3.25, 3.25) and (7.25, 3.25) to define a Line describing the
By Coords... path of the HB vehicle and click OK.

13



| Bridge
Moving Load
Analysis. ..

Simple Slab Deck

Moving Load Analysis X

Discrete load | 4:Pnt4 {HB 6.0m spacing 45.0 units) ~
Assignment

() Project onto line (2D line beams and frames)

(®) Project over area (grillages, shells, and 20 space frames)

Search area Whole model ~
Ciptions for loads outside search area | Exclude All Load w
Moments to include | None ~
Load path definition
Reference path Create reference path from selection
Direction of travel Forward ~
Path divisions
(® Move load along path in equal divisions Divisions |10 =
(O) Move load by incremental distance along path Distance | 1.05

Create loadcase envelopes

MName | Static Moving Load Analysis 1 w

OK Cancel Apply Help

Select the Line just defined.

e Ensure the discrete load is set to Pnt4: (HB 6.0m spacing 45.0 units).

o Ensure that ‘Options for loads outside search area’ is set to Exclude All Load.
¢ Ensure that ‘Moments to include’ is set to None.

e Set the option ‘Move vehicle along path in equal number of divisions’ to 10.

o Ensure that Create loadcase envelope is selected and click OK.

Loadcases 3 to 13 that represent the HB load moving forward across the bridge will be
generated in the C Treeview along with a maximum and minimum load envelope.

Checking loading

Loads on the model may be visually checked at any time by changing the active
loadcase.

14



| File

Save

Modelling

e From the @ Treeview select Loadcase 6 (s=5.25m), click the right-hand mouse
button and select the Set Active option to see the mid-span position of the
moving load. Note that the portion of the HB vehicle that is not included in the
loading on the deck is clearly shown by the grey colouration of the loading
arrows

This process may be repeated for any loadcase, and the isometric view button @I can
be used to rotate the model so the load directions can be seen.

Note. Visualisation of assigned loads is |4~ ~

controlled by options available from a Q Load visualisation on/off
droplist provided by the loading on/off
icon

Load visualisation by definition
Load visualisation by effect on model
Load visualisation by effect on mesh

% Load visualisation settings

Saving the Model

The model is now complete. The model data should be saved before running the
analysis.

El Save the model file.

15
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Running the Analysis

&

| File

New...

With the model loaded:

El Press the Solve Now button to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful

Analysis loadcase results are added to the (5} Treeview.

In addition, these files will be created in the LUSASFiles\<model name> folder:

O bridge_slab.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

O bridge_slab.mys this is the LUSAS results file which is loaded
automatically into the % Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully. You may
download this file from the user area of the LUSAS website.

U bridge_slab_modelling.lvb carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as bridge_slab

e Use the default User-defined working folder.

o Ensure an Analysis category of 2D Inplane is set.

16



| File
| Script >
| Run Script...

Viewing the Results

e C(Click the OK button.

Note. There is no need to enter any other new model details when a script is run to
build a model, since the contents of the script will overwrite any other settings made.

e To recreate the model, select the file bridge slab_modelling.lvb that was
downloaded and placed in a folder of your choosing.

Now return to the section entitled Assigning the Moving HB Vehicle Load earlier in
this example and continue from this point.

Viewing the Results

[View
| Page Layout Mode

| File
| Page Setup...

Loadcase results can be seen in the @ Treeview, and the loadcase results for the last
solved loadcase is set active by default.

The results will be examined. For this problem the following are required:

O A plot of the deformed mesh.

O A contour plot of bending moments in the X direction due to a load
combination.

O A graph showing the variation of bending moment along a section of the slab.
U A contour plot of Wood-Armer reinforcement moments in the slab.

Using Page Layout Mode

The model was created using a Working Mode view which allows a model of any size
to be created. Results could be viewed using this mode of operation, but in order to
allow additional information to be added without obscuring the model, Page Layout
Mode could be used instead.

The graphics window will resize to show the model on an A4 size piece of paper in
landscape orientation.

e Ensure that left, right top and bottom margins are set to 60, 10, 10 and 10
respectively and click OK

Displaying the deformed shape

The deformed mesh layer initially provided in the Treeview by the startup template
is turned on following a successful solve of the model. To see just the deformed mesh
of the model the Mesh, Attributes and Geometry layers will be turned off.

e In the Treeview, click the right-hand mouse button on the Mesh entry and
turn off the Display option. The mesh layer will be hidden from the display.

17



[ Window

Save View...

Simple Slab Deck

e Repeat to turn off the Attributes and Geometry layers.

El If necessary, use the Isometric view button to rotate the model to the view
shown.

Set the active loadcase

e Inthe (B Treeview right-click on Self Weight and select the Set Active option.

Note. If ever required, the local
coordinate system axes can also
be turned off by deselecting the
Show Definition option for the

Skew entry in the &% Treeview.

Saving a view
This page layout view can be saved for subsequent re-use with other models.

Enter the view name as Landscape Page Layout and click OK

Contour Plots

Results can be plotted as colour line or filled contour plots. Here, longitudinal bending
moments will be plotted as colour filled contours.

£ iy Return the model to the default starting view by pressing the Z axis field
on the status bar at the bottom of the graphics window.

e With no features selected click the right-hand mouse button in a blank part of
the graphics window and select the Contours option to add the contours layer to

the &= Treeview.
The contours properties dialog will be displayed.

e Select Entity Force/Moment
— Thick Shell Component
moments in the X direction
Mx

e C(Click the OK button to
display contours of moments
in the X direction.

18



Viewing the Results

Note. By default, in LUSAS Modeller, averaging of results is done for all situations
where it is appropriate. When it is inappropriate (as in this case where different
geometric thickness assignments have been made) no averaging of results across those
element boundaries takes place.

Moving information on the annotation layer

Text and other objects such as the contour key may be moved after their initial
placement.

e Click on one of the items of text on the contour key. (This will select the key
and enable it to be moved).

e Click and drag the object to a new position on the left-hand margin of the page.

Marking Peak Values

e With nothing selected click the right-hand mouse button in a blank part of the

graphics window and select the Values option to add the values layer to the
Treeview.

The values properties dialog will be displayed.
e Select Force/Moment — Thick Shell contour results of bending moment Mx

e On the same dialog, select the Values Display tab and ensure the Maxima and
Minima check boxes are selected to display the top 1% of results.

e Set the number of significant figures to 4
e Change the angle to 45 degrees.
e Select the Choose Font button and set the text size to 16 and click OK

e (lick the OK button to add
the extreme maximum and
minimum values to the
display.

If necessary, the values can be
seen in isolation by turning the
contours layer off and then on
again.
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| Analyses

Basic Combination

N

NS

Simple Slab Deck

Defining a Combination

Combinations can be used to view the combined effects of several results loadcases,
combinations or envelopes.

The combination properties dialog will appear. Loadcases Self Weight, HA & KEL
upper and the moving load envelope are to be included in the combination.

e With Analysis 1 expanded in the Available list select both Self Weight and HA
& KEL upper from the Name panel and click the LI button to add the
loadcases to the combination dataset with a factor of 1

e With Post processing expanded in the Available list select the envelope
Envelope (Static Moving Load Analysis 1) and click the LI button to add

the loadcase to the combination dataset.

Note. By default, loadcases are added to the combination with a factor of 1. This
factor may be changed by selecting the loadcase in the Included panel and changing the
load factor in the grid provided.

e Change the combination name to Max Design Combination and click the OK
button to finish.

Note. To obtain the correct effect from the combined loads the combination should
only include one occurrence of each loadcase. Envelope and Combination definitions
are held and saved within the model file.

Note. Changing the properties of the max or min envelope will change the definition
of both envelopes.

Selecting and Viewing the Combination Results

e Inthe @ Treeview right-click on Max Design Combination and select the Set
Active option.

e Select Force/Moment — Thick Shell results of component Mx and click OK

Note. When a combination includes an envelope the deformed mesh layer is not
available.

20



| Utilities

Graph Through 2D

Viewing the Results

The contour plot for Mx from the
load combination will be
displayed.

Note. The values layer is still
listed in the Treeview so the
maximum and minimum values
of Mx for the load combination
will also be shown.

Graphing the Results
of a Slice

A graph is to be plotted showing the variation in bending moment through a specified
section of the slab.

If the model is being viewed in
the XY plane (as it is) the By
Cursor option will be selected
and the Snap to grid option will
be available.

e Ensure that Snap to grid
is selected with a grid size
of 1

e C(Click the OK button.

e Click and drag the cursor along the centre of the lower lane (Y=3) to define the
location of a section slice through the slab.

Note. The Y ordinate of the slice can be seen in the status bar I 1:2 . The X
and Y scales on the sides of the window will also help this selection.

The graph X axis values of distance through the deck are defined by the slice section.
The graph Y axis results now need to be specified on the slice data dialog.

e On the Loadcases and Extent dialog ensure that Max design Combination is
selected and click Next.

e On the Slice Data dialog select Force/Moment — Thick Shell results for
Bending Moment in the X direction Mx and click the Next button.

The graph Y axis results have now been defined and title information for the graph can
be added.
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| File

Save

Simple Slab Deck

o Enter the graph title as Bending Moment Mx along lower lane
e Leave the graph X and Y axis names as their default names.
e Click the Finish button to display the graph.
Simple Bridge Slab Analysis
Bending Moment Mx along lower lane
10
0
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z ¥
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E -70 ,./
g -80
E 90
-100
-110
120 —
e T L R T E e
Distance
——#——Nix - 3:Max Design Combination (Max - Mx)(2) / Coordinates (<.3,0) to (9,3.0)(1)

Note. The graph properties can be modified by clicking the right-hand mouse button
in the graph window and selecting the ‘Edit Graph Properties’ option.

E Close the graph window.

il Click on the selection mode button to return to normal cursor mode.

Save the model

El Save the model file.

Note. When the model file is saved after results processing, all load combinations,
envelopes, and graph datasets, if defined, are also saved and therefore do not have to be
re-created if the model is amended and a re-analysis is done later.

This completes the example.
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Discussion

Discussion

Use of a regular mesh

In this example the geometry and mesh attributes result in a regular mesh aligned to the
global axis.
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Analysis: Analysis 1
Loadcase: 2:HA & KEL upper
Results file: slab_regular_mesh~Analysis 1.mys
Entity: Force/Moment - Thick Shell

Component (Averaged nodal): Mx (Units: kN.m/m)

137774
-63.2378
-52.6981
-42.1585
-31.6189

-21.0793
-10.5396
0.0

10.5396

Maximum 12 8754 atnode 52 of element 72
Minimum -81.9813 atnode 60 of element 92
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Use of an irregular mesh and transformation of results
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Results file: slab_irregular_mesh~Analysis 1.mys l

Entity: Force/Moment - Thick Shell
Component (Averaged nodal): Mx (Units: kN.m/m

-75.2668
-62.7223
-50.1779

- -37.6334

-25.0889
-12.5445
0.0
12.5445

. 25.0889 ‘j J
Maximum 32.5038 atnode 107 of element 82 \ \ \‘}%

Minimum -80.3964 atnode 63 of element24 PN .

Caution. The use of an irregular mesh would mean that the results obtained would
have different orientations over the whole slab and hence be incorrect. In this
circumstance a local coordinate set would need to be used to orientate the element
results to be consistent with the global axes in order to obtain sensible components for
use in the calculations.

e The mesh orientation can be viewed from the =¥ Treeview by selecting Mesh >
Properties and selecting the Show Element Axis option. Press OK to apply
changes.

e A local coordinate set can be created by selecting Attributes > Local
Coordinate and making a selection such as ‘x-axis’
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Discussion

e Results transformations can be applied by visiting a results layer’s properties
dialog and pressing the Transform Set... button and selecting the local
coordinate defined.

Analysis: Analysis 1
Loadcase: 2:HA & KEL upper
Results file: slab_irregular_mesh~Analysis 1.mys
Entity: Force/Moment - Thick Shell
Transformation: Local Coords "x-axis"
Component (Averaged nodal): Mx (Units: kN.m/m)

-73.538
-63.0326
-52.5272
-42.0217
-31.5163
-21.0109
-10.5054
0.0
10.5054

Maximum 12.6887 atnode 29 of element 15
Minimum -81.8602 at node 38 of element 45

This now shows a similar results plot to that obtained when using a regular mesh.
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